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1 Read Me First 
Digital Video Security System enables you to monitor and protect your business, home or 
office from across the hall or around the world.  The video grabber software provided with 
Digital Video Security System, allows you to set up a PC based security system in minutes 
that can: 

•  Stream Live Full-Motion Video – Watch what is going on in the next room, or around 
the world via the internet or dial up option 

•  Detect Motion – When the alarm feature is activated, the system will automatically 
dial a telephone or pager number that you have selected and play an emergency 
message. You can also have the system send an email. 

•  Record Digital Video – Manage digital recording sessions or save the video as a 
streaming file that can be replayed.. Review the video using still frame, forward, fast 
forward and other video management capabilities.   

•  Control Home Automation – Use any X10 Home Automation and Wireless devices 
to control lighting and other features available with X10-compatible systems 

•  Schedule Events – Schedule video recording, e-mail notification, X10 Home 
Automation and more based on a user-defined schedule 

1.1 Steps to Get Going 

Listed below are the recommended steps for installing Digital Video Security System: 

•  Check your package using the list on the next few pages to make sure you received 
the complete system. 

•  Confirm that your computer meets the system requirements for Digital Video Security 
System. 

•  Install Digital Video Security System 
  
1.2        How to Use This Manual 
This user’s manual describes the contents of Digital Video Security System and system 
requirements.  It also provides installation instructions and tells you where to go for more 
information. 

1.2.1     User’s Manual Layout 
This manual is designed to get you started quickly, while providing you with a full reference. 
Each chapter is self-contained so that the manual does not have to be read in sequence. 

The manual is divided into the following chapters: 

Chapter Title Description 

2 Installation Describes installation and setup of hardware and 
software 

3 Tutorial Overview of the main software features 
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4 Specifications Describes specifications for computer and camera 

5 Glossary Definitions of common terms used in this manual 

6 Support Outlines available support to Digital Video Security 
system users 

 

Screen shots in this manual have been taken on a system running Windows 2000.  
There will be small differences to the external appearance of the application 
windows and dialogs running on Windows XP. The layout of the windows and 
dialogs and their content are identical for all Windows systems supported. 

1.2.2         Symbols Used in This Manual 
Throughout this manual a set of comments are employed to provide emphasis to certain 
points. A left-hand icon indicates the type of comment as follows: 

 

 

This type of comment represents a feature or aspect of the Digital Video 
Security System that is particularly beneficial to the user. Text in this 
note is italicized and bold. 

 

 

This type of comment represents information that you will find useful, 
such as a shortcut or a “how-to” to avoid common mistakes. Text in 
this note is bold. 

 

 
THIS TYPE OF COMMENT REPRESENTS SOMETHING TO BE AWARE 
OF OR BE CAUTIOUS ABOUT. TEXT IS BOLD AND UPPERCASE. 

 

1.3 System Contents 

! Video Grabber with USB cable – A PC interface that allows you to connect 
a video device, such as a security camera, to your PC. 

! Software – The Digital Video Security System software application enables 
you to monitor and protect your business, home or office from across the 
hall or around the world. 

! Color Video Security Camera (included with the DVM2101-A & 
DVM2051-A system) – A high-quality color video security camera with 
cable and 9 V DC power supply.  Note:  if you purchased DVM2100 or 
DVM2050, you will need to purchase a video security camera. 
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! User’s Manual – Full reference to the features of Digital Video Security 
System. 

 
 

 

 

 

 
 

     Video Grabber 
      with USB Cable 

 

 
 

 
Application 
Software 

 
Owners 
Manual 

 
  Color Video Camera with 

57ft extension cable,  
 camera bracket and power 

supply  - Included with 
Model DVM2101-A,  

DVM2051-A 
     

 
 

 

DO NOT PLUG THE VIDEO GRABBER INTO THE USB 
PORT OF YOUR COMPUTER. YOU MUST FIRST RUN THE 
INSTALLATION SOFTWARE. 

1.4 Minimum System Requirements 

The minimum system requirements for the Digital Video Security System are: 

Processor Pentium II or higher 

RAM 32 MB Ram 

Windows O/S Windows 2000 or Windows XP 

Video Card Any VGA Compatible Video Card 

Display 800 x 600 VGA 

Sound Card Built into Color Camera with DVM2101-A, and 
DVM2051-A; Built in sound Card to most computers 

Disk Space 40 MB available hard disk space 
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Modem 28 bps or higher modem 

CD-ROM Drive Required for software installation 

Computer Connection USB 

Camera Included with DVM2101-A and DVM2051-A (not 
included with DVM2100 or DVM2050) 

1.5 Windows Help File 

The Digital Video Security System User’s Manual is available in modified form as a 
Windows Help file. To access the online Help file, click first on Help, then Help topics, and 
finally the Contents section from the Digital Video Security System application itself. 

1.6 Support 

The following 3 options are available for technical support: 

Type Contact Hours 

On-line Support  

 

 

Please visit our website at 
www.strategicvista.com for free 
technical information anytime and 
weekly updates to the most 
frequently asked questions 

24 Hours / 7 days a 
week 

Email Support  
 

 

 

 

Please email your queries to us 
at support@strategicvista.com 
If you are experiencing a 
technical problem, you can also 
send the configuration file to us 
for assistance 

Allow 24 Hours (Mon-Fri) 
for a technical support 
person to respond to 
your query 
 

 

Telephone Support Should you need to talk with a 
customer support representative 
please visit our website at 
www.strategicvista.com for the 
most up to date telephone 
customer support phone number. 
Note that a fee may apply for this 
service. 

Support available 7 Days 
a week  
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1.7 FCC Compliance 

This equipment has been tested and found to comply with the limits for a class B digital 
device, pursuit to Part 15 of the FCC rules.  These limits are designed to provide 
reasonable protection against harmful interference in a residential installation.  This 
equipment generates, uses and can radiate radio frequency energy and, if not installed and 
used in accordance with the instructions, may cause harmful interference to radio 
communication.  However there is no guarantee that interference will not occur in a 
particular installation.  If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, the user 
is encouraged to try to correct the interference by one or more of the following measures: 

•  Reorient or relocate the receiving antenna increases the separation between the 
equipment and receiver 

•  Connect the equipment into an outlet on a circuit different from that to switch the 
receiver is connected 

•  Consult the dealer or an experience radio or television technician for help. 

This device complies with Part 15 of the FCC rules.  Operation is subject to the following 
two conditions: 

1. This device may not cause harmful interference, and 

2. This device must accept any interference received, including interference that 
may cause undesired operation 

This digital apparatus does not exceed the Class B limits for radio noise emissions from 
digital apparatus set out in the Radio Interference Regulations of the Canadian Department 
of Communications. 

ALWAYS USE DISCRETION WHEN INSTALLING VIDEO AND AUDIO SURVEILLANCE 
EQUIPMENT ESPECIALLY WHEN THERE IS PRECEIVED PRIVACY.   INUQIRE 
REGARDING FEDERAL, STATE AND OR LOCAL REGULATIONS APPLICABLE TO 
THE LAWFUL INSTALLATION OF VIDEO AND OR AUDIO RECORDING OR 
SURVEILLANCE.  PARTY CONSENT MAY BE REQUIRED 
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2 Installing Digital Video Security System 
This chapter describes how to install Digital Video Security System.  You will need a video 
security camera (included with DVM2101-A and DVM2051-A) to operate this system.   
 
 
Screen shots in this manual have been taken on a system running Windows 2000.  
There will be small differences to the external appearance of the application 
windows and dialogs running on Windows XP. The layout of the windows and 
dialogs and their content are identical for all Windows systems supported. 
 
 
 

 

DO NOT PLUG THE VIDEO GRABBER INTO THE USB PORT OF YOUR 
COMPUTER. YOU MUST FIRST RUN THE INSTALLATION SOFTWARE. 

 

2.1 Installing the Software Application 

To install the Digital Video Security System software application, simply insert the Software 
Application CD into your computer’s CD-ROM. After a few seconds the Setup application 
will automatically run. 

On some systems the Windows auto-start is turned off. If the Setup application does not 
run within a few seconds after you place the installation CD in the CD-ROM drive, go to the 
Start - Run option.  Select browse to find the CD-ROM drive and double-click the Setup.exe 
file. 

When the Setup starts up you will see the Windows Installer main window: 
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Follow the instructions of the standard Windows installation dialog, which will guide you 
through the installation process.  

 

 

YOU MUST ACCEPT THE LICENSE AGREEMENT PANEL OR THE 
INSTALLATION WILL NOT CONTINUE. 

 
The next two panels will require you to accept the license agreement, and enter your 
customer information.  You will then be prompted with the following Setup Type panel:  
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Select the Complete Setup option and click on Next. The installation may appear to pause 
during the installation process. If this happens let the installation software proceed. It is 
automatically configuring your Windows environment to determine what it needs to install in 
order for the Digital Video Security System software application to operate properly. The 
following window will update you as to the progress of the installation:  
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The installation automatically installs Windows Media Player 9 Series if it is not already on 
your system. The Digital Video Security System is based on a Widows Media platform, and 
WM9 offers improved streaming audio/video performance from previous versions of the 
software. 

 

 

 



  
 

Digital Video Security System Start Up Guide  
 
 

11

 
 

Once Windows Media 9 is installed, you will be prompted with a setup dialog for DirectX. 
DirectX is the core Windows® technology that drives high-speed multimedia and games on 
the PC. For more information on the features of DirectX, please refer to the following link: 

http://www.microsoft.com/windows/directx/default.aspx 

 

 

An advantage of having a Windows Media platform is that Windows 
Media software is constantly being improved. As Windows Media 
improves, the audio and video streaming quality of the Digital Video 
Security System improves as well! 

 

Follow the instructions of the standard DirectX 9.0 installation dialog, which will guide you 
through the installation process. 
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After DirectX 9.0 is installed, the installing process for the Digital Video Security System 
application software will resume. When the installation is completed you will see the 
following window. 

 
 

Once the installation of the Digital Video Security System application is complete, you must 
Restart your system in order for the new settings to take effect. 
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2.2 Connecting the Hardware 

Once the installation of the Software Application and Video Drivers is completed, connect 
the Video Grabber to the USB port on your computer using the supplied cable.  

 

 
 
The Video Grabber is designed as a Plug-and-Play device. The Windows device manager 
will automatically finds and recognizes the Video Grabber with the Found New Hardware 
Wizard. 

The following image depicts the Video driver being automatically detected and installed by 
the Found New Hardware Wizard.  

 

 
 



  
 

Digital Video Security System Start Up Guide  
 
 

14

Your system may ask you to specify the location of both the Audio and Video Drivers. 
Select the CD-ROM drive. The New Hardware Wizard will locate the Drivers on the 
software CD. 

 

 
 

The Audio and Video Drivers with both install sequentially one after the other. You may be 
asked to restart your system between the Audio Driver and Video Driver installation. 
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The next image shows the installation of the Audio driver being completed. 

 

 
 

 

DEPENDING ON YOUR SYSTEM, THE VIDEO AND AUDIO DRIVERS MAY 
NOT BE DETECTED AND INSTALLED IMMEDIATELY AFTER PLUG-IN OF 
THE HARDWARE. IF ONE OF THE TWO DRIVERS ISN’T BEING 
DETECTED, TRY UNPLUGGING AND REPLUGGING THE USB DEVICE, 
OR RESTART YOUR PC. 

 

 

SINCE DRIVERS ARE INSTALLED IT IS RECOMMENDED TO RESTART 
YOUR SYSTEM EVEN IF THE INSTALLATION DOES NOT REQUIRE IT, 
PRIOR TO PLUGGING IN YOUR VIDEO CAMERA. 

 

 

You can now plug any video security camera into the Video Grabber (included with 
DVM2101-A or DVM2051-A). This security camera should have an RCA audio/video 
connection along with a 9V power supply. You can now start monitoring your business, 
home or office.  
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2.3     Setting Up/ Installing Your Video security Camera 

For users who purchased model DVM2100 or DVM2050, refer to your Video Security 
Cameras owners’ manual for installation of your security camera.  Once the security 
camera has been set up, simply connect the RCA audio/video cable from the camera to the 
Video Grabber. 

For users who purchased model DVM2101-A or DVM2051-A, proceed with the following 
steps: 

1. Attach the camera bracket to the camera.  Position the security camera in the 
desired viewing location.  Note:  A color camera requires a certain level of light.  
You may need to adjust the camera position and/or the amount of light in the 
room for optimum viewing. 

2. Run the supplied 17-meter (57ft) cable from the camera to the video grabber.  
Connect the audio and video RCA leads to the Video Grabber and plug the 
camera into an electrical outlet using the supplied 9 V DC power supply. 

Refer to the Technical Specifications at the back of this manual for detailed information on 
this camera. 

 
 
 
 

If this was your first time setting up a security system, congratulations! 
You just set up a sophisticated digital video monitoring system in 
minutes! Continue to the next chapter and you will be watching video in 
another couple of minutes. 
 

 
2.4       Connecting your PC to a DVR (Digital Video Recorder) using the supplied  
            Video Grabber (Optional) 
 
By connecting a DVR to your existing PC, using the supplied Video Grabber, and a camera 
connected to the DVR (using a BNC connection), you are able to transfer recorded video  
from the DVR to your PC. Please follow the following steps: 

1. Do the necessary connections as depicted in the connection diagram below 
2. Any video that was recorded by the DVR through the local camera (BNC 

connection) should be rewinded back to the beginning for playback to 
commence. Press “Play” on the DVR followed by the “Pause” button. 

3. Assuming that your Application Software is installed on your PC, double click on 
the DVM icon on your desktop to start the application 

4. Press the “Play” button on the DVR to continue the playback 
5. Click on the “Recording” button in the DVM application software window 
6. Click on the “Stop” button in the DVM application software when the video 

transfer is complete. Press the “Stop” button on the DVR   
 Later,  this information stored on your PC’s Hard drive can be transferred or burned on a 
CDRW/DVDRW/PC Media, etc. This enables the user to have back-up recorded 
information on both the DVR and PC. 
 
Below is a local monitoring and recording configuration:  
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2.5      To Uninstall 

To uninstall the Digital Video Security System go to the Add/Remove Program options in 
the Control Panel of Windows. Click on the DVM System item to uninstall the main Digital 
Video Security System application. The Digital Video Security System Uninstall program 
will prompt you with the following window: 
 

 
 
 
Select “Yes”  to remove the Digital Video Security System application from your computer. 
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3 Tutorial 
This tutorial will introduce you to the basic concepts of the Digital Video Security System 
application, with the goal of getting you up and running quickly in 30-45 minutes.  It will 
provide you with an understanding of how to navigate through the Digital Video Security 
System software to set up a basic security system with minimum effort. A more complete 
description of all of the powerful features of the Digital Video Security System application is 
contained in the Reference section of the Help menu. 

This tutorial uses a case study approach that assumes you are the owner of a thriving 
store. You have hired a new employee to manage the store in your absence.  You are 
working out of your home office and would like to do the following: 

•  Monitor how the cash register is closed down for the day; 
•  Check on your store at random during the day from your home office; 
•  Ensure that there are no intruders after business hours.   

You can use the Digital Video Security System software for all these capabilities, and more. 
Let’s get started! 

3.1 Launching the Application 

To launch the Digital Video Security System application, select it from the Programs | DVS 
menu option, or click on the DVS System icon. 

Upon entering the program, you will immediately see live video from the camera! Please 
close this window for now in order to follow the Tutorial and gain a better understanding of 
the software. 

3.2 Quick Overview of the Interface  

Digital Video Security System is comprised of a main application window from which you 
launch and control the specific features of the application 

3.2.1 The Main Application Window: An overview 
The main window contains four areas and appears as follows:  

•  The menu bar; 
•  The toolbar; 
•  The status bar; 
•  The main window or work area; 
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Upon launching the Digital Video Security System, the default layout of the application will 
appear as follows:  

 

 

 
 

The menu and tool bars provide you with access to the feature set of the Digital Video 
Security System application. The main window is where all launched windows will open, 
and the status bar provides you with feedback on any operation Digital Video Security 
System is carrying out. By default, a Connections window and a Feedback window will be 
opened in the main Digital Video Security System window. By default, the layout is 
designed to fit an 800 x 600 pixel screen.  Whether you maintain the default layout, or 
modify it to one that better suits your needs, Digital Video Security System will maintain 
your layout between sessions. That is, if you shut down the application and re-launch it at a 
later time, the main application window will appear just as you last left it.  This is referred to 
as persistence – all values, such as the layout, connection information, and configuration 
settings, persist between sessions. 

 A camera connection called Main Camera has already been set up for you. 

Menu Bar 

Tool
Bar 

Connections 
Window 

Main 
Window 

Feedback  
Window 

Status 
Bar 
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3.3 Getting Started 

Using the case study scenario described in the introduction to the tutorial, your store will be 
set up as the local surveillance connection. The local surveillance is always the location of 
the video camera. Later in this tutorial you will set up your home office as the remote 
surveillance connection. The remote surveillance is the location from which you will 
remotely monitor and control the security at the store.  

 

 

3.3.1 Setting up a Local Surveillance Connection  
 
You will use this window to set up the local connection to the video camera in your store.   

 
  

A preset default Connection has already been created for you. Please refer to the next two 
sections for instructions on Opening Connections and Viewing Video Locally. However, 
before proceeding, it is important to practice setting up your own connection. 

 

 

A local connection is set up at the computer that has the Video 
Grabber, camera and Digital Video Security System software installed. 
It is referred to as Local Video because the security camera is 
connected directly to this computer.  The Digital Video Security 
System will stream video from this location to the internet, thus it is 
sometimes also referred to as the host computer. 

 

 

Note that the Connections Window has its own toolbar. All windows 
have their own toolbar for added convenience and ease-of-use. 

 

To set up your own connection, select the  New Connection icon. You will be 
presented with the following Add Connection dialog box: 
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Type a descriptive name in the label field; in this example “Store Surveillance Camera”.  

The Connection Information area will have the connection method, video device and audio 
device pre-selected as the default setting.  

For this tutorial leave the Login information fields blank.  

 

Select OK, and the new connection is added. It is that simple! You will see your new 
connection listed in the Connections window, as shown below: 

 

 

Login information is an optional setting, however very important.   
Login information protects the camera from unauthorized use as only 
those people who know this information are able to access the 
camera. (refer to Setting Up a New Local Connection in the Reference 
section of the Help menu  for more details) 
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All connections are automatically saved when you exit the application. 
You do not have to specifically save your connections. 

 

3.3.2 Opening the Local Video Surveillance Connection  
Now that the connection has been set up, you will open the connection window in order to:  

•  Monitor the video camera locally 
•  Enable remote locations to monitor the local camera 
•  Optionally establish alarms and set up the corresponding trigger actions  

•  Optionally set up scheduled events 
 

 

Digital Video Security System allows you to schedule events or alarms.  
A scheduled event is when you pre set a specified date and time.  For 
example if you want to record a picture every day at 9:00am, you would 
schedule this event.   An alarm is a set when motion is detected at the 
camera.  For example, if someone were to come into the warehouse at 
nighttime, digital video security system will trigger the computer to 
begin recording to your computer’s hard drive. 

 

 

To open the connection you have just set up, select the Store Surveillance Camera 
connection by either double-clicking on its label, or by highlighting the label with your 

mouse and selecting the  Open Connection icon from the Connection window.  The 
following Local Video Surveillance window will open:  
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The Local Video Surveillance maintains the connection label in the title 
bar to identify which connection it is controlling. This is the descriptive 
label that you entered when creating the connection. 

 

3.3.3 Viewing Video Locally  
 
Upon opening the connection, live video will appear (allow approximately 10 seconds for 
the camera picture to appear). This lets you preview what will be transmitted remotely, and 
enables you to adjust your camera appropriately for both local and remote viewing. 

To stop the video camera from displaying in the window, simply press the  Stop button 

on the toolbar. After video is stopped, you can press the  Play icon to resume viewing 
video. 

3.3.4 Adding Alarms  
In this next section, we will cover how to set up an alarm that will detect security breaches 
based on motion detection.  Once again, an alarm is set when motion is detected at the 
camera.  For example, if someone were to come into the warehouse at nighttime, digital 
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video security system will trigger the computer to begin recording to your computer’s hard 
drive.  An alarm can trigger the following events:  

•  Notify you via e-mail; 
•  Automatically dial a phone or pager; 
•  Capture the motion on video; 
•  Turn ON or OFF lights or other electrical devices using X-10 controllers 

 
3.3.5      Motion Detection 

The Digital Video Security System includes a powerful and flexible motion detection 
capability that can be calibrated to suit most environments. Digital Video Security System 
has a built in pixel based motion sensor feature.  If movement is detected within the camera 
screen, motion will be detected and various alarm sequences (eg. Record video, email, 
etc.) will commence.  

In order to activate Motion Detection (it is defaulted to OFF), click on the  icon, and 
select the Motion Detection Setting as Active. The screen will blink with a Yellow color 
when motion is detected. 

                  
Active:  You have the option to have motion detection ON or OFF. The default setting is 
set to OFF. To activate the motion feature, add a check mark by clicking the Active 
checkbox 
 
Alarm Duration (seconds):  Alarm Duration is set to 30 seconds, meaning that DVS will 
wait 30 seconds between each motion being detected before it activates. For example: If 
the Motion Detection is set to compare video frames every 1/10 of a second, then moving 
very slowly with imperceptible changes between video frames can evade detection. 
Likewise, if the Motion Detection is set to compare frames every 3 seconds, then moving 
quickly in between these checks can also evade detection. 

Lighting: Depending on the environment the camera is installed in, you will have 4 
selectable settings:   

1. Standard Indoor 
2. Fluorescent 
3. Outdoor 
4. Sunny Outdoor 
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Range:  There are 4 selectable motion detection ranges:  

1. Up to 5 feet 
2. 5 to 10 ft 
3. 10 to 20 ft 
4. More than 20 feet 

In order to set up an alarm for Motion Detection, click on the  New Alarm icon in the 
Local Video Surveillance window.  The Motion Detection Alarm dialog will open, as shown 
in the following screen: 

 
 

 

 

DVM already has Record Video as the first default action item. This 
means that if motion is detected, DVM will automatically record the 
picture for the 20 second duration and save the file on your computer’s 
hard drive. 
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DIGITAL VIDEO RECORDING MAY USE UP DISK SPACE AND SHOULD 
THEREFORE BE USED CAUTIOUSLY.  EACH MINUTE OF VIDEO 
RECORDING IS APPROXIMATELY 1.5 MB.   

 

Type in a descriptive label for the alarm; in this example, “Weeknights”. 

 

 

You can set up multiple alarms.  Each one is identified by a unique 
label that you select. Refer to the reference section for more details. 

 

Fill in the Begin and End times that the Motion Detection Alarm should be active. For 
example, in this case we will select the nighttime hours when the store is closed. To 
change the times, position your mouse in the hours, minutes or AM/PM field, and use the 
up or down arrows to scroll to your desired settings. Alternatively, you can highlight any of 
the fields and type the desired information in manually, one field at a time. 

In the Scheduled Days region, select the  button.  This will automatically 
check the days from Monday through Friday.   

 

 

If you accidentally pressed OK and closed out of this dialog, your 
information is still saved. Click on the Alarm label in the Local Video 
Surveillance window to re-open the Motion Detection Alarm dialog. 

 

The Motion Detection Alarm dialog will now appear as follows: 

 



  
 

Digital Video Security System Start Up Guide  
 
 

27

 
 

In the next section, you will add the Actions that should occur upon detection of motion 
such as sending an e-mail, dialing a phone or pager, recording video, playing an audio file 
or activating an X-10 device.  

3.3.6 Setting Actions in Response to an Alarm 
You can set up as many actions as you want as a result of motion being detected, including 
multiple occurrences of the same type of action. This section of the tutorial reviews setting 
up one of each possible action.  

 

 

Digital Monitoring System executes alarm actions simultaneously. 
This means for example, that DVM will record video, send email and 
call a phone at the same time. Within one action, however, the action 
is sequential. For example, if you have Digital Video Security System 
set to call four different telephone numbers, DVM will dial the phone 
numbers in the sequence that it was entered. 

 

Fore more details on setting Motion Detection, refer to Motion Detection in the Reference 
section of the Help menu. 
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3.3.6.1 Send an E-Mail 
To add an action that sends e-mail as a result of motion detection, select Send e-mail from 
the Add Action drop-down box in the Motion Detection Alarm window and click Add.  You 
will see the following dialog: 

 

 
 

As with most e-mail systems, enter the address and fill in the subject and message fields.   

However, before testing or applying the Email Action, you must first configure your Email 
settings in the Configuration dialog. To enter the Configuration dialog, go to the menu bar 
and select View.  From the drop down menu, select Configuration. Then select the Email 
tab, and enter your SMTP Server and From Address as shown in the following dialog: 
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To obtain your SMTP Server information, you can inquire with your internet service 
provider. Alternatively, it you are using Microsoft Outlook, you can click on Tools in the 
main menu bar, and select Accounts from the drop down menu. Then click on Properties, 
and select the Servers tab in order to find your SMTP Server. 

Before selecting OK on the email itself to confirm the Email Action, you can first test the e-
mail by selecting the Test option. This will immediately send the e-mail to the selected 
address, so you can ensure it will be sent to the correct recipient in the case of an alarm.  

 

 

All of the Action dialogs give you the option of testing your settings. 
Testing your settings confirms that your e-mail (or any other email 
action) ends up where you expected. 

 

 

In order for email to operate, you will need to be connected to your 
internet provider.  

 

Select OK. With these simple few steps, you have established that if motion is detected 
between the hours of 9:00 PM and 8:00 AM on weekdays, a 20 second video will record to 
your computer’s hard-drive, and a pre-specified text e-mail alert will be sent.   

The Motion Detection Alarm window will appear as follows:  
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In the window that lists the actions, the Details column provides a brief 
summary of the action so that you can easily identify it. 

 

3.3.6.2 Dial a Telephone or Pager 
To add an action that places an automated call to a telephone or pager as a result of 
motion detection, select the Dial Phone or Pager option from the drop down Action Menu 
and click ADD. You will see the following dialog: 
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Enter the phone number of the emergency contact and the dial (DTMF) tones you will be 
sending to the pager. (For full details on the various aspects of this Action, please refer to 
“Action: Dial a Telephone or Pager” in the Reference section of the Help menu). You can 
optionally place dashes (‘-‘) to present the phone numbers in familiar form (999-9999), 
though this will not affect how the number is dialed out.  Wait to connect is the amount of 
delay time you want prior to the dial tone or audio file to be sent.  For example, if the wait to 
connect was sent to 10 seconds, Digital Video Security System will wait 10 seconds after 
dialing the phone number to start playing a specified audio message. 

 

 

A DTMF Tone is simply the sound you hear when you press the 
buttons of a standard phone. DTMF Tones correspond to the numbers 
on the phone keypad (i.e., 0 through 9). DTMF stands for Dual-Tone-
Multi-Frequency. 

 

To ensure that the call goes where you intended, use the Test feature.  This will place an 
immediate call according to the information you have entered.  

 

 

Sending a test phone or pager message does not affect any operation 
when motion is detected. It is merely a convenience to ensure that 
you entered information correctly into the dialog. 

 

 

If your system does not have a TAPI compliant modem, the telephone 
action will not dial out. The modem must support both voice and data 
communication in order to operate properly. Many built-in modems 
are only designed for data, not voice, and some built-in modems may 
not support TAPI. TAPI stands for Telephony Application Program 
Interface 

 

Press OK. Now you have established that, in the event of motion detection during the hours 
of 9:00 PM and 8:00 AM during the week, three actions will take place: a 20 second video 
will record to your computer’s hard-drive, a pre-specified e-mail will be sent and; third an 
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automated telephone call will be placed to a pager. The Motion Detection Alarm window will 
appear as follows:  

 
 

Note that two Actions to the same alarm are now listed in the Actions region of the Motion 
Detection Alarm window. 

3.3.6.3 Play Audio File 
 

The audio alarm allows you to be alerted by an audio sound when motion is detected at the 
camera’s location. The audio sound will alert you to look at your computer to see what is 
happening at the computer.  

From the Motion Detection Alarm dialog, choose Play Audio File from the Add Action 
drop-down list and click Add.  The following dialog will appear: 



  
 

Digital Video Security System Start Up Guide  
 
 

33

 
 

Select an audio file from the dialog box by pressing the  button. Press the Play 
button to hear the audio file that you selected. Alternatively, you can also Record your own 
audio message as a .wav file that can serve as your audio alarm. 

Press OK. You have now established that, in the event of motion detection during the hours 
of 9:00 PM and 8:00 AM during the week, four actions will take place:  

•  A 20 second video will record to your computer’s hard-drive 
•  A pre-specified e-mail will be sent; 
•  An automated call will be placed to a pager; 
•  An audio file will play to alert you of motion at the camera 
 

The Motion Detection Alarm window will appear as follows:  
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Note that four Actions to the same alarm are now listed in the Actions window of the Motion 
Detection Alarm window. 

3.3.6.4 Activate X-10 
To add an action that controls X-10 devices such as lights and other electrical outlets as a 
result of motion detection, select Control X-10 devices from the Add Action drop-down box 
in the Motion Detection Alarm window and press Add.  You will see the following dialog: 

 

 
 

House Code: Selectable from A to P 
Device Code: Selectable from 1-16 
Command: ON, OFF or DIM 
Percent Dim: When “DIM” is selected for the command, a percentage of dimness can be 
entered here. 
Port: Selectable ports include COM 1 – COM 4 
 

 

Strategic Vista, the manufacturer of Digital Video Security System is 
not affiliated in any way with X-10. You will need to contact X-10 
directly to purchase the “Firecracker” and other X-10 devices. 

 

 

In order to use the X-10 capabilities, you need to purchase a CM17A X-
10 wireless computer interface (Home Automation System), otherwise 
known by its nickname “FireCracker”. The FireCracker device is a 
small connector that plugs into the Serial port of your computer and 
transmits an RF signal to an X-10 receiver, TM751 that is plugged into 
the wall. Consult with X-10 to see what other feature / options can be 
made available through X-10 for use with Digital Video Security 
System. 

 
Enter the House and Device Codes that, in combination, might identify the lights in the front 
of the store.  You may either input the code values using your keyboard, or select the 
desired value from the drop down boxes to the right of each field.  (For details about valid 
input values for these fields, refer to “Action: Control X-10 Devices” in the Reference 
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section of the Help menu; for a brief overview of the X-10 protocol, please see the X-10 
Reference section of the Help menu). 
Set the Command to ON, indicating that the lights should turn on when motion is detected.   

Running Test will turn on the selected lights immediately, confirming that you have 
accurately entered the Codes you desired. 

Press OK. You have now established that, in the event of motion detection during the hours 
of 9:00 PM and 8:00 AM during the week, five actions will take place:  

•  A 20 second video file will record to your computer’s hard-drive 

•  A pre-specified e-mail will be sent; 

•  An automated call will be placed to a pager; 

•  An audio file will play to alert you of motion at the camera 

•  Lights in the front of the store will turn on.  

 

The Motion Detection Alarm dialog will appear as follows:  
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Note that five Actions to the same alarm are now listed in the Actions region of the Motion 
Detection Alarm window. 

You may close the Motion Detection Alarm dialog by pressing OK.  Your Local Video 
Surveillance window will now reflect the Alarm you have just added:  

 

 
  

 

You can edit the Alarm you just created by double-clicking on the 
Weeknights alarm icon. 

3.3.7 Adding Scheduled Events  
Let us now focus on the events that you may choose to schedule on a regular basis. A 
Scheduled Event is a set of actions that are designated to occur on a weekly basis at pre-
designated times. One example might be to have all the lights automatically turn off at 
night, or recording the closing out of the cash register every evening.  Adding a Scheduled 
Event is as easy as adding an alarm and can include:  

•  Sending an e-mail 
•  Automatically dialing a phone or pager 
•  Recording video 
•  Controlling X-10 devices 
•  Playing an audio file 

 



  
 

Digital Video Security System Start Up Guide  
 
 

37

 

The Scheduled Event dialog enables you to flexibly select events that 
can be scheduled in any combination of days or times of the day, such 
as weeknights, weekdays, weekends, etc. 

To demonstrate the simplicity of adding a Scheduled Event, which is nearly identical to 
adding an Alarm, let us walk through the two examples mentioned above, which are setting 
the lighting at a pre-designated time and recording the cash register every evening. 

3.3.7.1 Open Scheduled Event Dialog 

From the Local Video Surveillance window, which should still be open, click on the  
Add Scheduled Event. The following dialog will appear:  

 
 

 

 

Notice that the Schedule Event and Motion Detection Alarm windows 
are almost identical. You can apply all that you learned in the last 
section to quickly go through setting up actions based on a scheduled 
event. 
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With the exception of the Scheduled Time field, this dialog is identical to the Motion 
Detection Alarm dialog.  (In setting up an Alarm, you choose both a start and end time; for 
a Scheduled Event you need to select only a start time.) 

 

Type in a descriptive label; ours reads “Turn Off Lights.” 

Enter 10:00 PM in the Scheduled Time field by positioning your mouse in the hours, 
minutes or AM/PM field, and using the up or down arrows to scroll to the correct time. 
Alternatively, you can highlight any of the time fields and manually type in the desired 
information, one field at a time.  

In the Scheduled Days region, select the  button.  This will automatically 
check all seven days.   

The Scheduled Event window will appear as follows:  
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3.3.7.2 Activate X-10 
You can now specify which action you would like to schedule; namely, accessing the X-10 
protocol to turn off all lights.  

 

 

Setting up any of the Actions in a Scheduled Event – e-mail, dial a 
phone or pager, record video or activate X-10 – is identical to setting up 
an Action in response to an Alarm. 

 

From the Add Actions drop-down list, select Control X-10 devices and press Add.  The 
following dialog will open:  

 

 
 

Enter the House and Device Codes that, in combination, identify all of the lights in the 
store.  You may either input the code values using your keyboard, or select the desired 
value from the drop down boxes to the right of each field.  (For details about valid input 
values for these fields, refer to “Action: Control X-10 Devices” in the Reference section of 
the Help menu; for a brief overview of the X-10 protocol, please see the X-10 Reference 
section of the Help menu). 
Set the Command to OFF, indicating that all lights should be shut off.   

Running Test will turn off the selected lights immediately, confirming that you have 
accurately entered the Codes you desired. 

Press OK.  

The Scheduled Event window will appear as follows:  
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You have now established that every night, at 10:00 PM, all of the lights in the store will be 
turned off. 

Press OK on the Scheduled Event Window to save these settings.  As shown below, the 
Local Video Surveillance window will reflect that both an Alarm and a Scheduled Event 
have been established:  
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3.3.7.3 Record Video 

From the Local Video Surveillance window shown above, select the  Schedule Event 
icon.  When the Schedule Event window opens, enter the following information:  

 

 

Event Label: Cash Register Closing 

Scheduled Time: 9:00 PM 

Scheduled Days: Check all days but Sunday 

Your Schedule Event window should look like this:  
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From the Add Action drop-down list, select Record video and press Add.  When the Video 
Record Action dialog opens, input the following information:  

Duration: 20 seconds 

Continuous Record:  unchecked 

The Video Record Action Dialog will look like this:  

 

 
 

Running Test will immediately capture the pre-specified 20 seconds of video, and will store 
the video capture in the default video record file. 
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Press OK. You have now established that six nights a week, at 9:00 PM, Digital Video 
Security System will record a 20 second segment of video and store it for future reference.  

The Schedule Event window will appear as follows:  

 

 
 

Select OK to close the Schedule Event window.  

Your Local Video Surveillance window will now reflect that you have established one Alarm 
and two Scheduled Events for the Store Surveillance Camera: 
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3.3.8 Enabling Local Surveillance to be Viewed Remotely 
Once your local camera is set up properly in the store, you can enable it to be viewed 
remotely by others. When you open the Local Video Surveillance you can control whether a 

remote workstation can view the local video camera using the  Connect and  
Disconnect icons found on the Local Video Surveillance toolbar. Once the Local Video 
Surveillance is connected, it is ready for a remote workstation to view the local video 
camera, as described in the next section. 

3.3.9 Setting up a Remote Surveillance Connection 

 

In order for you to set up a remote location you must have the DVM 
software loaded on both computers and connected with your internet 
provider. The local/host computer must be kept on and the application 
must be open. 

 
Once your local camera is properly set up in the store, you can move to your home office, 
where you will set up a Remote Video Surveillance connection.  Using this remote 
connection, you will be able to:  

•  Remotely monitor the live video feed from the store’s security camera; 
•  Remotely establish new Alarms or Scheduled Events for the store; 
•  Remotely modify existing Alarms and Events. 
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There are two methods for establishing a remote connection to the 
host (local) computer: Fixed IP Address and Yellow Pages Entry. This 
tutorial demonstrates how to remotely connect to a host computer 
that has a Fixed IP Address. For details on remotely connecting to a 
host computer using the Yellow Pages Entry, please refer to the 
Yellow Pages Directory in the Reference section of the Help menu. 

 

Install the Software Application CD at your home office location following the directions in 
Section 2.1. Launch the application, as per instructions in Section 3.1.  

Upon entering the software from a remote location, you will find a dialog stating that “No 
Video Device is detected”. This message appears because the same software CD is used 
for both Local and for Remote applications. Simply click OK, ignore the message, and 
proceed to establish a Remote Surveillance Connection. 

From the main window of the Digital Video Security System application, click on the  
Connections icon, or select View | Connections, as you did in Section 3.3.1.  Once the 

Connections window has opened, select the  New Connection icon. Fill in the fields of 
the Add Connection dialog box as follows: 

Type in a descriptive label for this remote connection: “Home Office”. 

The Type of Connection will be pre-selected as Video Surveillance.  

Use the Connection Method drop-down list to select Fixed IP Address.   

Your Add Connection dialog will now appear as follows:  
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Please note that the Connection dialog now has a new field requesting the Fixed IP 
Address. Enter the IP address of the computer at the store where you have the camera 
connected. (For more details on Connection Methods for Remote Connections, please refer 
to Remote Connections in the Reference section of the Help menu). 

 

 

If you need assistance to locate your computers IP address go to the 
menu bar and select help.  From the drop down menu, select About  
Digital Video Security System.  Your IP address will be shown.   

 
 

Press OK. 

That’s it! Your Remote Surveillance Connection has been set up! 

As shown in the following screenshot, the Connections window displays all of your 
established connections.  

 

 
 
Icons on the left represent whether the connection is local or remote, as follows: 

 

Denotes a LOCAL connection (i.e., the camera is connected to 
the PC at this location) 

 

Denotes a REMOTE connection (i.e., will connect you to a 
video camera at a remote location)  

 

Connection Icons Description  
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3.3.10 Viewing Live Video Remotely 
From the Connections window (as shown in the previous section), select which remote 
video connection you would like to access by double-clicking on its label with your mouse, 

or highlighting the label and selecting the  Open Connection icon. You will be 
presented with the Remote Video Surveillance window, as shown:  

 

 

To remotely view the security camera footage live, press the  Connect Icon. The video 
will play in the right side of the Remote Surveillance Window (first allow for 100% Buffering, 
and then wait about 10-15 seconds for the streaming video to appear). 

 

 

Digital Video Security System provides you live streaming video.  
There is a latency period of about 15 seconds.   

 

To stop viewing the video from the remote location, simply press the  Disconnect icon. 
You can connect and disconnect to the remote video as often as necessary. For further  

details about remotely viewing live video, please refer to “Remote Surveillance Window” in 
the Reference section of the Help menu. 
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3.3.11 Video Playback  
To replay previously captured video, use Digital Video Security System’s convenient Video 

Playback feature.  From the main window, select the  Video Playback icon.  The 
following window will open:  

 

 
 

On the left-hand side of the window, you will see a listing of all video files stored in your 
default directory. (For more details on Configuring your default video directory, refer to 
Configuration in the Reference section of the Help menu) To view the video capture, 
double-click on the video of your choice.  Video is played in the right-hand panel of the 
Video Playback window, using the embedded Window Media Player. 

 

 

 

When the video listing is in Detail mode, it automatically lists the date, 
start and stop times, and Local Video Surveillance camera that recorded 
the video. 

 

For more details on Video Playback and navigating the Windows Media Player, please 
refer to Video Playback in the Reference section of the Help menu.
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3.3.12    Additional information on setting up a remote connection, Including:   
           Viewing Remotely, Yellow Pages, Firewalls, Video Testing & Troubleshooting  
 
(These instructions are based on the local and host system being Windows 2000 or 
Windows XP)(All screen shots in the section are based on Windows XP) 

 
NOTE: In order for one computer to connect to another, both computers must 
have access to the Internet. 

 
Key Terms: 
Local (host) System – The PC that has the physical camera attached 
Remote System – The PC that is connected to the local system 
DVS – This is the Digital Video Security System software 

How to setup the local system: 
 
1). Open (start) the DVS software by double clicking on the DVS icon on your desktop 

                                               
2). When you start the DVS software you should see two windows. The top one is for 
     Connections and the bottom one is for Feedback. 
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3). In the Connection window, you should see at least one item, and by default it is called  
      Main Camera. 
 
4). Double click on the item labeled Main Camera in the Connection window. 
 
5). A new window should open up. The new window should be titled “Local Video 
     Surveillance: Main Camera”. 
 
6). The Local Video Surveillance: Main Camera window is divided into a two paned 
      window. After a few seconds video should appear right pane. 
 
 

 

 
If video does not appear, check the Feedback window and see what messages are posted.   
(a) If this is the first time that you are running the DVS software, follow the setup 
     instructions on how to install and setup the camera and the software.  

 
(b) If you have had the system up and running in the past, and you have not made any 
     changes to your computer hardware and have not installed any new software, then just 
     reconfirm that the camera is plugged in the Video Grabber and has power. Also confirm 
     that the grabber is attached to your computers USB jack properly. Finally, reboot your 
     PC and try it again. If the problem persists, then please contact Strategic Vista support. 
 
7).In the Local Video Surveillance: Main Camera window, click on the Connect icon. The 
    video window will go black for a few seconds then come back again. 
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8). After the video returns, you will notice that the Connect icon is now grey and the 
     Disconnect icon is in blue and available. 
 

 
 
9). In the Feedback window you should see the following message: 
 

 
 
NOTE: In order for one computer to connect to another, both computers must have 
broadband access to the Internet. 

  
10). There are currently two possible ways for you to connect a remote site to the local 
       (host) system:  
       a. Fixed IP address 

   b.Yellow Pages 
 
The Remote - Fixed IP address and the Remote – Yellow Pages options will work 
ONLY if: 
- you know the IP address of the Host system 
- The IP address of the local (host) system is static (does not change) 
- The IP address of the local (host) system is reachable from the remote location*. 
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* To test if the local system is reachable, go to the section titled How to test a Remote 
IP below. 
 
To setup a Yellow Pages entry: (You must be connected to the Internet to 
compete the following steps.) 
i.  From within the DVS software, click on File and then click on Register with Yellow  
   Pages. 

                                 
 

ii. The Yellow Pages Registration dialog box will appear. 
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i. Type a name in the Label box that identifies your system. NOTE: While the 
Yellow Pages directory is only for the DVS software, the label that you choose 
must be unique. If the name you choose is already in use, you will be prompted 
to select a different label. 

 
ii. Enter and confirm a password for this entry. Choose a password that you will 

easily remember. 
 

iii. The choice to publish the label name in the Yellow Pages is up to the individual 
user. If you choose to accept the default setting and leave the Publish Label item 
checked, then every DVS Yellow Page users will be able to see the name. If you 
opt to not publish the label, you will need to remember the label that you 
assigned to the local (host) system. 

 
iv. Note the Current IP Address. For issues regarding IP Addresses, please read the 

section titled How to test a Remote IP below.  
 

v. Press OK 
 

vi. The Yellow Pages entry is now setup. 
 

(NOTE: In the DVS software, if you click on Help > Help Topics, the DVM 2100 
/DVM2101-A/DVM2050/DVM2051-A help window  will open.  
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Click on Broadcast Local Surveillance and read the tutorial on how to setup a Fixed IP 
and Yellow Pages entry connection. 
 
******THE NEXT STEPS MUST BE COMPLETED ON THE REMOTE SYSTEM****** 
 
Before continuing, please read the section titled How to test a Remote IP below to 
confirm that your remote system can connect via IP to the local (host) system. 

 
Once again we have provided a tutorial on how to setup a remote station in the Help 
Topics that is provided with the DVS software. To access it, click on Help > Help 
Topics. The DVM 2100/DVM2101-A/DVM2050/DVM2051-A help window will open, 
click on Broadcast Local Surveillance and View Remotely and read the information 
on the right pane window. 

 
11).  On the remote system, start the DVS software. 

 
12).  In the Connections window, click on the icon to create a new connection 
 

                                  
 
13).  A new Connection dialog box will appear. 
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14).  Under the General section, enter a Label for this new connection. For example, you 
        could enter “Remote” or “Home Office”. 

 
15).  In the Connection Information section, click on the drop down box next to Connection 
        Method. 
 
 

 
 
 
 
16). Please read step 10 above (and the Broadcast Local Surveillance section on Help) 
       for the differences on Fixed IP and Yellow Pages. 
 
17). If you select Remote - Fixed IP, enter the IP address of the local (host) site. (Once 
       again, this can be found on the local (host) system, in the Help > About Digital Video 
       Security System dialog box.) 
 
18). If you select Remote – Yellow Pages Entry, click on the “…” box at the end of the 
       Remote – Yellow line. (Note: you must be connected to the Internet for this to work.) 
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19). The Browse Yellow Pages dialog box will appear. Scroll down until you find your entry.  
       Click OK. 
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20). You are now back at the Connection dialog box and your Yellow Pages name should 
       be in the Remote – Yellow box. 
 

 
NOTE: If either the local (host) system or the remote system is connected to the 
Internet via a slow broadband or dial up connection, please read the section on 
Advanced Connection settings below. 
 
21).  Click on OK 

 
22).  You are now back at the Connections window. You should see the new connection 
        that you just created. 
 

 
 
23). Double click on this new connection. 

 
24). The Remote Video Surveillance: Remote (or what ever name you entered) will open. 
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25). Click on the Connect icon 
 

                
 
26). The remote system will attempt to connect to the local (host) system 

 
27).  If, at the bottom of the Windows Media Player window, your system keeps displaying  
        “Buffering …” and never displays video, you might need to adjust the connection 
        speed setting. To do this, please follow the steps in the Advanced Connection Settings  
        section later in this document. 
 
28).  If your remote system connects to the local (host) system for a few seconds and then 
        disconnects, he problem is usually the connection speed setting on the local (host) 
        system. Read the Advanced Connection Settings section later in this document. 
 
29).  At this point, your remote site should be connected to the local (host) system. If you 
        are not able to connect, check the Feedback window and see what errors (Red dots) 
        are displayed. NOTE: If you are able to connect the video, but the Connect button 
        remains blue – follow step 30. 
 
30).  For testing purposes there is also an alternate method to test the video connection 
        remotely. For more information, read the Alternate Video Test section later in this 
        document. 



  
 

Digital Video Security System Start Up Guide  
 
 

59

       Please read the Troubleshooting section later in this document – while this does not 
       cover all the errors that could arise, it reviews the most common ones.  
 
31). Please review the tutorials provided in the Help > Help Topics section for more 
       information on setting up Alarms and Scheduled Events. 

How to test a Remote IP connection: 
 
For a remote system to connect to a local (host) system, the local (host) system needs 
to be “connectable” to. 
To test this, you will need to gather some info as follows: 
 
l) On the local (host) system, in the Digital Video Monitor System (DVS) software click 
   on Help > About Digital Video Security System. 
 

        ll) In the About Digital Video Security… window you will see the following pertinent  
           information 
 

                                      
 

Version number: _______________ 
IP Address: ________________ 
 
As of this writing, the latest version of the DVS software is 1.20.145. If you are not 
running this version, please go to the section labeled “How to update the DVS 
software” later in this document. 
 
lll)  Once you have the local (host) system’s IP Address, go to the computer that will 
     be used as the remote system.  
 
lV) Click on Start menu, and then click on Run.  

 
V) The Run dialog box will open. In the Open: line type “cmd” and click on OK. 
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I) A black background window will open. At the cursor “C:>” type “ping ip 

address”. Replace ip address with the IP address that was on the local 
(host) system. IT IS IMPORTANT THAT YOU TYPE IN THE IP ADDESS 
AS IT APPEARED, THIS INCLUDES THE “.” 
 
For example, on my system, I would type “ping 192.168.1.100” 
 

II) Press the Enter key 
 
III) In the black window, you will get 4 responses to this. 

a. If the response reads: Reply from ip address, then your local (host) 
system is reachable. YOU ARE GOOD TO GO. 

b. If the response reads anything else (this is somewhat general) then 
you will have a problem connecting your remote system to the local 
(host) system. 

 
IMPORTANT Additional IP Address information: 
If the IP address on your computer falls into the following ranges, it means that your 
computer is on a “private” network: 
 
Class A) 10.0.0.0 - 10.255.255.255 
Class B) 172.16.0.0 - 172.31.255.255 
Class C) 192.168.0.0 - 192.168.255.255 
 
If the IP address on your computer falls into the Auto IP range, it means that your computer 
is not properly connected to any network: 
 
Auto IP) 169.254.0.0 -169.254.255.255 
 
If either of your computers, the local (host) system, or the remote system has an IP that is 
in the Auto IP range, the remote monitoring will not work on this computer as it is currently 
connected to the Internet. 
 
If both of your systems are on the same LAN (local area network - meaning the computers 
are in the same physical location; such as, the same office building or the same house) 
then the local (host) system and the remote system MUST have an IP Address in the same 
class and should have the a similar numbering scheme. Some examples are: 
 
Class A network: if the local (host) system has an IP Address of 10.151.1.3, then the 
remote system should have an IP Address that begins with 10. 
 
Class B network: if the local (host) system has an IP Address of 172.16.1.3, then the 
remote system should have an IP Address that begins with 172.16. 
 
Class C network: if the local (host) system has an IP Address of 192.168.1.3, then the 
remote system should have an IP Address that begins with 192.168.1. 
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In general if your local (host) system and remote systems have the same Class IP Address, 
but are not on the same network (meaning the computers are in separate, not physically 
connected locations; such as, one computer is at the office and one computer is at home) 
then your local (host) system is located behind a router and/or a firewall.  
 
If either system is behind a firewall, whether software or hardware based, it is very 
possible that you will not be able to get the remote monitoring features to function. 
 
If the local (host) system has an IP Address that DOES NOT fall into any of the private IP 
Addresses ranges, then even if your remote system does, the remote system should be 
able to connect to the local (host) system. 
 
For advanced firewall configuration information please check the firewall providers’ web 
site. For some basic firewall configuration information please read the “How to configure 
basic firewall features” section later in this document. 
 
NOTE: IP Addressing and IP connectivity issues can be very technical and complicated. If 
you are unsure or are having problems testing a “ping” between the local and remote 
systems, please contact a local computer technical person to assist you. 

How to update the DVS software: 
The Check for Updates feature in the Digital Video Security software will only update the 
software to the latest point release. If there is a new version of the software, you will have 
to purchase it. 
 
A point release means that if you are at version 1.20.143 and version 1.20.145 has been 
released, you can update your software over the Internet to this version. If however version 
2.XX.XXX has been released, you will need to purchase it. 
 
To update your DVS software to the most recent point release, click on Help and then on 
Check for Updates and update the software until your DVS software is updated. As of April 
2004 the current version is 1.20.145. 
 

                  
If updates are available, follow the Updated Wizard’s steps and update the DVS software. 
 
If no updates are available, click the Finish button on the dialog back that appears 
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How to configure basic firewall features: 
Firewalls come in many forms, from software based, such as Windows XP’s built in firewall 
and Zone Alarm’s free personal firewall, to hardware based firewalls. As such, it is beyond 
the scope of CoreVideo to advise you which firewall product to use and how each product 
is to be configured. 
 
The DVS software is Internet ready and the video from the local (host) site can be 
transmitted over the internet to a remote system. As you read above, there are two 
methods provided to enable this connection: Remote Fixed IP and Remote Yellow Pages 
entry. 
 
By default, the DVS software utilized IP Port 85, however, this IP Port number is 
changeable if the user desires. 
 
To change the IP port, you will need to modify settings on the local (host) system as well as 
the remote system. 
 

i) On the local (host) system, go to the Connections window and right click on 
the camera entry that is currently in use or that will be used. 
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ii) From the drop down menu, select Edit Connection 
 
iii) The Connection dialog box will open. 

 
 

 

 
iv) Click on the Advanced button 
 
v) The Advanced Connection Information dialog box will open 
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vi) As you can see, the default IP Port is port 85. You can change this to what 

ever you want. NOTE: If you do change it, it is best to change it to 
something over 5500. 

 
vii) Press OK 
 
viii) Press OK again 
 
ix) You will need to go to the remote system and repeat these steps on the 

remote entry that you created in the Connection window. 

Advanced Connection settings: 
If after you have setup the local (host) system, started the Main Camera (or, if you created 
a different connection on the local (host) system) and have started the remote entry in the 
Connection window on the remote system, and at the bottom of the Windows Media Player 
window the word Buffering is displayed, but no video actually appears, your connection 
between the two sites might not be fast enough for the two sites to connect. 
 
To adjust the connection speed settings, go to the local (host) system. 
 

i) On the local (host) system, go to the Connections window and right click on 
the camera entry that is currently in use or that will be used. 
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ii) From the drop down menu, select Edit Connection 
 
iii) The Connection dialog box will open. 

 
 

 
iv) Click on the Advanced button 
 
v)            The Advanced Connection Information dialog box will open 

 
v) Click on the drop down list next to Video Profile 
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vi) Select the top item, “Video for dial-up modems or single channel ISDN (28.8 

to 56 Kbps) 
 

vii) Click OK 
viii) Click OK again. 
 
ix) Once again, you only need to do this on the local (host) system and not the 

remote. 
 

x) Go back the remote system and try to connect again. 
 

xi) If problems persist, please record any errors (red dots) on the Feedback 
window and contact Strategic Vista support. 

Alternate Video Test Method: 
There is an alternate method that can be used for testing the remote video connection. It is 
important to note that this method will NOT use the DVS software and therefore will NOT 
allow you access to any of the features provided by the DVS software. This is just for 
testing purposes. 
 
Requirements for alternate test method: 

- Windows PC with latest version (and updates of) Windows Media Player 9 
installed 

- The local (host) system must be accessible via its IP Address (see the How to 
test a Remote IP connection section.) 

 
- You must know the IP Port that the local (host) system is using (read the How to 

configure basic firewall settings section.) 
 

i) With the information that you have gathered start the Windows Media 
Player.  

 
ii) From the menu on the Windows Media Player click on File > Open URL 
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iii) In the Open URL dialog box, type in the IP Address of the local (host) 
system followed by a colon (:) and then the Port number. 

 

             
 

iv) Then press OK 
 
v) Windows Media Player will attempt to connect to the local (host) system. 

 
vi) Once again, this connection is not utilizing any of the advanced features 

available in the DVS software, including the bandwidth optimization. 
 

Troubleshooting: 
 
The remote connects but… 
 
1) NOTE: If after your remote system connects to the local (host) system, you see that 

the Connect button is still blue and the Disconnect button is grey, please check the 
Feedback window. 
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2) If you see the following messages in the Feedback window and yet you can see video 
from the local (host) system, you are experiencing a Microsoft Direct Show error. This 
error, while still allowing you to view video, prohibits you from setting Alarms and 
Scheduled Tasks remotely. 

 

 
 
The remote does NOT connect… 
 
3) If after your remote system does not connect to the local (host) system, and you see 

that not only does the Connect button remain blue and the Disconnect button is grey, 
but at the bottom of the Windows Media Player window is does NOT display 
“Buffering…” please check the Feedback window. 

 

                          
 

4) If you see the following messages in the Feedback window and yet you cannot see 
video from the local (host) system, you system is not finding an live local (host). To fix 
this, go to the local (host) system and start the Main Camera (or, if you created a 
different connection on the local (host) system) in the Connection window. 
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Specifications  
 

The following is the minimum system requirements for Digital Video Security System: 

 
Processor Pentium II or higher 

RAM 32 MB Ram 

Windows O/S Windows 98, Windows ME, Windows 2000 , Windows 
XP 

Video Card Any VGA Compatible Video Card 

Display 800 x 600 VGA 

Sound Card Built into Color Camera with DVM2101-A & DVM2051-
A; Built in sound Card to most computers 

Disk Space 40 MB available hard disk space 

Modem 28 bps or higher modem 

CD-ROM Drive Required for software installation 

Computer Connection USB 

Camera Included with DVM2101-A & DVM2051-A (not 
included with DVM2100 & DVM2050) 

 

 

 

 

 

 

 

 

 

 

 

 

 

FOR MORE INFORMATION: 
 

www.strategicvista.com 
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4 Camera Specifications 
 

Image Device   Color CMOS 

Picture Elements  510 x 492 

Horizontal Resolution  330 TV lines 

 

Minimum Illumination  3 lux @ F2.0 

S/N Ratio   More than 48 dB 

Auto Electronic Shutter  EIA 1/60 s – 1/150,000 s 

Scanning System  Interlace 2:1 

Video Output   1 Vp-p / 75 ohms 

Audio Output    2 Vp-p/ 50 ohms 

Power Supply   9 Volt (supplied) 

Operating Temperature  -10 º c to +45 º c (14 ºF to 113 ºF) 

 
 

 

ALWAYS USE DISCRETION WHEN INSTALLING VIDEO AND AUDIO 
SURVEILLANCE EQUIPMENT ESPECIALLY WHEN THERE IS 
PRECEIVED PRIVACY.   INQUIRE REGARDING FEDERAL, 
STATE/PROVIINCIAL AND OR LOCAL REGULATIONS APPLICABLE 
TO THE LAWFUL INSTALLATION OF VIDEO AND OR AUDIO 
RECORDING OR SURVEILLANCE.  PARTY CONSENT MAY BE 
REQUIRED.    

 

 

 
As our products are subject to continuous improvement, SVII and its subsidiaries reserve 
the right to modify product design, specifications and prices, without notice and without 
incurring any obligation. E&OE  
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5 Glossary 
 

Broadband – Broadband is a general term used to refer to a fast Internet connection. 

DSL – DSL is a type of Internet connection that runs over standard telephone wire. 

DTMF tones – DTMF Tones are the sounds that a phone makes when you press one of 
the keys. DTMF stands for Dual Tone Multi-Frequency. 

Dynamic IP – Dynamic IP is an IP Address (refer to Glossary definition of IP Address) that 
changes periodically. 

IP Address – An IP Address is the unique address of your computer on the Internet. 

ISP – ISP is the Internet Service Provider that connects your system to the Internet. 

Local Surveillance Connection – A local connection is set up at the computer that has 
the Video Grabber, camera and Digital Video Security System software installed. It is 
referred to as the “Local Video” because the security camera is local to this computer. The 
Digital Video Security System will stream video from this location to the internet, thus it is 
sometimes referred to as the host computer. 

Local TCP/IP Host – A Local TCP/IP Host is the computer that is hosting a camera which 
is streaming video onto the Internet. 

MAPI-compliant – MAPI is a standard for sending e-mail. Most E-mail systems follow the 
MAPI standard, such as Exchange and Outlook. MAPI stands for Messaging application 
Programming Interface. 

Remote Surveillance Connection – A remote connection is set up at any computer that 
has the Digital Video Security System software installed without a camera. Use the remote 
connection to log into your host security camera, giving you the ability to remotely view the 
streamed video and to configure many of the Digital Video Security System features from a 
remote site. 

TAPI – TAPI is a standard for dialing phone numbers using a modem. A TAPI-compliant 
modem is one that understands TAPI signals from the computer. TAPI stands for 
Telephony Application Program Interface. 

.wav fil – A .wav (Wave) file is a type of file that contains just recorded audio (as opposed 
to video). 
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6 Support 
 

The following 3 options are available for technical support: 

Type Contact Hours 

On-line Support  

 

 

 

Please visit our website at 
www.strategicvista.com for free 
technical information anytime and 
weekly updates to the most 
frequently asked questions 

24 Hours / 7 days a 
week 

 

 

 

 
Email Support  
 

 

 

 
 

 
Please email your queries to us 
at support@strategicvista.com 
If you are experiencing a 
technical problem, you can also 
send the configuration file to us 
for assistance 

 
Allow 24 Hours (Mon-Fri) 
for a technical support 
person to respond to 
your query 
 
 
 
 

 
Telephone Support 

 
Should you need to talk with a 
customer support representative 
please visit our website at 
www.strategicvista.com for the 
most up to date telephone 
customer support phone number. 
Note that a fee may apply for this 
service. 
 

 
Support available 7 Days 
a Week 

 

 


